
Installation & Operation Guide

This manual is the operation guide for “Medal Editor”. Please refer to this manual to install the software or
create medal data used on the processing machine.



Items That May Not Be Copied

Unauthorized reproduction of a copyrighted item for any purpose other than personal use may be a
violation of copyright.  Roland DG Corp. will not be responsible for any violation of third-party copyright
by any article made through use of this product.
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Getting Started

What Is Medal Editor?

Medal Editor is software used to create 3D images from 2D images such as pictures and illustrations. You can engrave
the 3D images on material using the processing machine. Also, you can add frames and text to your designs.
In addition, you can simulate processing operations using the supplied software “Virtual MODELA”. You can preview
the processing results and check the time required for processing. This helps to reduce lost time and wasted material.

Displaying the Online Help

For information on how to operate the supplied software and drivers, refer to the online help.

Using the [Help] menu

From the [HELP] menu, click [Contents].

Using the [Start] menu

From the [Start] menu, choose [All programs (or Pro-
grams)], then [Roland Medal Editor], then [Medal Editor
Help].

Using the [?] button

If you click the [?] button on the upper right of the win-
dow, the mouse cursor changes to “  ”. Then click the
term to display an explanation for the term.

Using the [Help] button

If you click the [Help] button, you can display the help
information related to the current window or software.
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Chapter 1
Installing and Setting Up

This chapter describes installation and setup procedures for the sup-

plied software and dedicated drivers.
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1-1 System Requirements

System Requirements for Installing the Software

System Requirements for USB Connection

• The ability to make a USB connection depends on the specifications of the computer. To determine whether the
computer you're using is capable of correct USB operation, check with the manufacturer of the computer.

• Use a shielded USB cable having a length of 3 meters or less. Do not use a USB hub or the like.

Operating system

Computer

Drive

Monitor

Memory (RAM)

Free hard-disk space required
for installation

Interface

Windows 98/Me/2000/XP

Computer running Windows (Pentium processor or better recommended)

CD-ROM drive

Windows-compatible monitor capable of displaying 256 colors or more (Full
colors recommended)

256 MB or more recommended

5 MB

USB port

Operating system

Computer

Windows 98/Me/2000/XP  (Windows 95 and Windows NT4.0 are not supported.)

1) Computers preinstalled with Windows 98/Me/2000/XP at the time of purchase
  (This includes such computers later upgraded to Windows Me/2000/XP.)

2) Computers on which USB operation is assured by the manufacturer of computers
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1-2 Overview of the Supplied Software

The software included in the supplied CD-ROM are as follows.

Medal Editor

Virtual MODELA

Windows driver

Medal Editor is software to create 3D images from 2D images such as pic-
tures and illustrations. You can add frames or text to your designs.

Virtual MODELA is software to simulate processing operations. You can
preview the processing results and check the time required for processing.
This helps to reduce lost time or wasted material.

A USB driver and Windows drivers required for transmitting data from
your computer to the machine are included.

For information on how to operate the supplied software, refer to the online help for each software.

☞  See "Displaying the Online Help."
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1-3 Installing the Software

1 Switch on the computer and start Windows.

If you are installing under Windows XP/2000,
log on an account with "Administrators" rights.

2 Place the included CD-ROM in the CD-ROM
drive.
The Setup menu appears automatically.

3 Install Medal Editor.

Click [Roland Medal Editor  Install].
The Setup program starts.

4 Follow the messages to carry out setup and fin-
ish setting up the program.
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1-3 Installing the Software

5 Click [OK].
The Setup menu appears.

6 Continue with installing Virtual MODELA.

Click [Virtual MODELA  Install].
The Setup menu appears.

7 Follow the messages to carry out setup and fin-
ish setting up the program.
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1-4 Installing the Drivers

Windows XP

1 Before you start installation and setup, make
sure the USB cable is not connected.

2 Log on to Windows with the “Administrator”
account.

3 Place the included CD-ROM in the CD-ROM
drive.
The Setup menu appears automatically.

4 Turn on the processing machine.

5 Connect your computer to the processing ma-
chine using a USB cable.
The [Found New Hardware Wizard] appears.

Keep the machine and the computer unconnected until you carry out this installation operation. Failure to follow the correct
procedure may make installation impossible.

☞  See "1-4 Installing the Drivers"  "What to Do If Installation Is Impossible."

USB cable
Processing machine
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1-4 Installing the Drivers

6 Choose [Install the software automatically (Rec-
ommended)], then click [Next].
Installation of the USB driver starts automatically.

7 When the screen appears, click [Continue Any-
way].

8 Click [Finish].
This completes the installation.
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1-4 Installing the Drivers

Windows 98/Me/2000

1 Before you start installation and setup, make
sure the USB cable is not connected.

2 Log on to Windows. If you are installing under
Windows 2000, log on with the “Administrator”
account.

3 Place the included CD-ROM in the CD-ROM
drive.
The Setup menu appears automatically.

4 Click [Windows Driver  Install].
The screen shown at right appears.

5 Select [Install]. From [Port] box, select [USB],
then click [Start].
Installation of the driver starts.

Keep the machine and the computer unconnected until you carry out this installation operation. Failure to follow the correct
procedure may make installation impossible.

☞  See "1-4 Installing the Drivers"  "What to Do If Installation Is Impossible."
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1-4 Installing the Drivers

6 When all installation finishes, the screen shown
at right appears. Click [Close].

7 When the setup menu for installation reappears,
click .

8 Remove the CD-ROM from the CD-ROM drive.

9 Turn on the processing machine.

10 Connect your computer to the processing ma-
chine using a USB cable.

USB cable Processing machine
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1-4 Installing the Drivers

What to Do If Installation Is Impossible

Windows XP/2000

1 If the [Found New Hardware Wizard] appears,
click [Finish] to close it.

2 Windows XP

Click the [Start] menu, then right-click [My Com-
puter]. Click [Properties].

Windows 2000

Right-click [My Computer] on the desktop. Click
[Properties].

3 Click the [Hardware] tab, then click [Device
Manager].
The [Device Manager] appears.

4 At the [View] menu, click [Show hidden devices].

5 In the list, find [Printers] or [Other devices], then
double-click it.

When your processing machine or [Unknown
device] appears below the item you selected,
click it to choose it.

6 Go to the [Action] menu, and click [Uninstall].
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1-4 Installing the Drivers

7 The screen shown at right appears.

Click [OK].

8 Close the [Device Manager] and click [OK].

9 Unplug the USB cable from your computer.

10 Uninstalling the driver.

Follow the procedure in "1-5 Uninstalling the
Driver", step 3 and after to uninstall the driver.

11 Follow the procedure in "1-4 Installing the
Driver" to redo installation from the beginning.

Windows 98/Me

1 Unplug the USB cables from your computer.

2 Appear the setup menu of the CD-ROM.

3 Uninstalling the driver.

Follow the procedure in "1-5 Uninstalling the
Driver", step 3 and after to uninstall the driver.

4 Follow the procedure in "1-4 Installing the
Driver" to redo installation from the beginning.
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1-5 Uninstalling the Drivers

Windows XP/2000

When uninstalling the driver, perform following operation.

1 Before you start uninstallation of the driver,
unplug the USB cables from your computer.

2 Log on to Windows as “Administrators” account.

3 Windows XP

From the [Start] menu, click [Control Panel].
Click [Printers and Other Hardware], then click
[Printers and Faxes].

Windows 2000

From the [Start] menu, click [Setting]. Then Click
[Printers].

4 If your processing machine appears, click the
icon.
From the [File] menu, choose [Delete].

5 When the screen prompting you to confirm de-
leting appears, click [Yes].

6 From [File] menu, click [Server Properties].
The next screen appears.
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1-5 Uninstalling the Drivers

7 Click the [Drivers] tab.

If your processing machine appears, choose the
name from the list, then click [Remove].

8 When the screen prompting you to confirm de-
leting appears, click [Yes].

9 Place the included CD-ROM in the CD-ROM
drive.
The Setup menu appears automatically.

10 Click [Windows Driver  Install].
The screen shown at right appears.

11 Select [Uninstall], then click [Start].
When driver is deleted, the next screen appears.

12 Click [Yes] to restart the computer.
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1-5 Uninstalling the Drivers

Windows 98/Me

1 Before you start uninstallation of the driver,
unplug the USB cables from your computer.

2 Place the included CD-ROM in the CD-ROM
drive.
The Setup menu appears automatically.

3 Click [Windows Driver  Install].
The next screen appears.

4 Select [Uninstall], then click [Start].
When driver is deleted, the next screen appears.

5 Click [Yes] to restart the computer.
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1-6 Configuring Medal Editor

Follow the procedure below to configure a default processing machine for Medal Editor.

1 Starting Medal Editor

When using Windows XP

From [Start] menu, choose [All Programs], then
[Roland Medal Editor], then [Medal Editor].

When using Windows 98/Me/2000

From [Start] menu, choose [Programs], then
[Roland Medal Editor], then [Medal Editor].

2 From the [File] menu, click [New Data].
The Edit screen appears.

3 Click the [Cut Settings] button.
The [Cut Settings] dialog box appears.

4 Click [Output Device].
The [Print Setup] dialog box appears.
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1-6 Configuring Medal Editor

5 Click [Printer Name] and select the processing
machine's name, then click [OK].

6 The [Cut Settings] dialog box appears again.

Click [OK] to close the [Cut Settings] dialog box.
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Chapter 2 Processing

This chapter describes the procedure from creating modeling data to

processing.
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2-1 Preparing Images

Image Suited for Processing

Prepare images (pictures and illustrations) to use as a processing design.
We recommend using images that meet the following conditions.

Portrait

• No shading on the face
(Lit from the front with no shading around the nose and eyes is best.)
• Front view
• Close up of face if using only the face
(Using a face from a full-length photograph may cause rough processing due to low resolution.)
• Background with uniform color

Objects other than portraits

• Solid color division (Illustrations or logos with few color gradations)
• Background with uniform color

File format

• BMP file
• JPEG file
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2-2 Names and Functions

File management screen
Displays the thumbnail list of the edited medal data
and image data. You can preview multiple data on
this screen.

Thumbnail
Double-click the file to display the
image data on the Edit screen.

Edit screen
Displays image data to be edited.

Material
Displays the size of the material.

Object settings
Displays item properties (3D Object, Text Object, or
Frame Object), including settings or operating buttons,
selected on the Edit screen.

When click 3D image : 3D Object appears.
When click text : Text Object appears.
When click frame : Frame Object appears.

When selecting a material or other area, properties do
not appear.

Layout (top view)
Displays the layout of the 3D
image, text, and frames.

Layout (side view)
Displays the conceptual dia-
gram of the height.
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2-3 Creating Processing Data

Loading Image Data

We use the following image data as an example to create processing data.

1 From the [File] menu, click [Open].
The [Open] dialog box appears.

2 Select the image file you want to use and click
[Open].
The selected image is loaded and appears on the Edit
screen.

Frame

3D image
Back ground

3D creation
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2-3 Creating Processing Data

Specifying the Material Size

Input the size of the material set on the vise.

In the [Material Diameter] field, input the diameter of the
material.
In the [Base Depth] field, input the processing depth.

Specifying the Processing Size

Input the size of the processing size.

Material diameter

Base depth

Bottom height

Graving height

Diameter

Top depth

Material

3D image

Side view

Top depth

Displays the depth from the top surface of the
material to the highest processing level of the 3D
image.

Graving height
Displays the processing height of the 3D image.

Bottom height

Displays the height of the push-up bottom of the
3D image. When you start processing the lowest
level, input the value "0".

Diameter
Displays the diameter of the 3D image surrounded
with circle.
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2-3 Creating Processing Data

Creating a 3D Image from a 2D Image (Object)

Create the 3D image by using [Create 3D (Object) ].

Click the [Create 3D (Object)] button.
The Work Area screen appears.

Specifying a work area

Specify the area from the original image to use for creating the 3D image.

1 Drag the mouse over the screen to specify the
work area.

2 Click [Next].
The 3D Creation Area screen appears.

Work area
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2-3 Creating Processing Data

Specifying a 3D creation area

Specify the area to use for creating the 3D image as a relief.

1 Click the point 1, 2, 3 shown in the illustration.

2 Click [Next].
The Background Area screen appears.

3D creation area

3D creation area

1
2

3
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2-3 Creating Processing Data

Specifying a background area

Specify the detailed area to use for creating the 3D image. The area specified as the background is not used.

1 Click the  button and click the part of the
image to specify as a background area.
The clicked part is filled and the Filled Area dialog box
appears.

2 Use the slide bar or [Wide]/[Narrow] buttons to
adjust the size of the filled area to be specified
as the background.
The filled area appears on the screen.

3 Use [Pen tool] to fill detailed areas.

Click  and drag the cursor over the area to
be specified as the background.

4 Click [Next].
The Mask Area screen appears.

Background area

Background area
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2-3 Creating Processing Data

Specifying a mask area

When converting an image to 3D, specify the black area
is raised or lowered. By specifying a mask area, the black
area are lowered.

You do not need to specify them here.
Click [Next].
The 3D Creation screen appears.

Converting a 2D image to a 3D image

Follow the procedure below to convert an edited 2D image to a 3D image.

1 Click the [Preview] button.
The simulated 3D image appears on the screen.

2 Check the simulated 3D image. Drag the slide
bar to the left/right to adjust each processing
parameter.

To preview the adjusted image, click the [Pre-
view] button.
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2-3 Creating Processing Data

3 Click the [Execute] button.
Data processing starts and the created 3D image appears.

4 Click [Finish].
The Edit screen appears.

Adjust the 3D image
If you want to adjust the 3D image, click the button shown
in the illustration.
The [Edit 3D] dialog box appears.

Use the configuration buttons or brush to adjust the 3D im-
age in detail.
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2-3 Creating Processing Data

Creating a 3D Image from a 2D Image (Face)

When creating a 3D facial image, you can specify nose and eye locations and a facial outline.

Loading image data of face.
Follow the procedure "Creating a 3D Image from a 2D Image (Object)", specify a work area and 3D creation area.

Specifying eye locations

1 Specify eye locations.

Move the cursor to the right eye and left-click
over the eye.

Move the cursor to the left eye and right-click
over the eye.

2 Click [Next].
The Nose Location screen appears.

Specifying  nose location

1 The location of the nose is detected automati-
cally.

Drag the [     ] marks on the screen to adjust the
location and size.

2 Click [Next].
The Outline screen appears.

For information on creating a 3D image from
a 2D image (face), refer to the online help.

Left-click
Right-click
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2-3 Creating Processing Data

Specifying  a facial outline

1 The facial outline is detected automatically.

Drag the [     ] marks and drag the slide bar to
the left/right on the screen to adjust the loca-
tion and size.

2 Click [Next].
The Background Area appears.

Follow the procedure "Creating a 3D Image from a 2D Image (Object)", specify a background area and mask area to
create 3D image.
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2-3 Creating Processing Data

Adding Text

Follow the procedure below to add text to the 3D image.

1 Click the [Add Text] button.
The [Add Text] dialog box appears.

2 Type the text you want to add in the [New Text]
field.

In this procedure, the text “Rose” is used as an
example.
The text you entered appears on the screen.

Changing the text alignment and font settings

To change the text height
Input a value to specify the height of
the text.

To duplicate text
You can duplicate text.

To delete text
You can delete text.

To change layout

You can change layout of text.

To change font settings
The [Text Settings] dialog box appears. You
can change the font style and size.

To change the text location
Move and rotate the text by dragging
it up, down, or to the left or right.

To change the font size
Drag the [     ] marks on the screen to
adjust the size of the text

ROSE�
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2-3 Creating Processing Data

Adding a Frame

Follow the procedure below to add a frame around an image.

Click the [Add Frame] button.
The new frame appears on the screen.

Changing the frame alignment and shape

Frame

To duplicate frame
You can duplicate frame.

Frame

To change layout
You can change layout of the frame shape

To change the frame shape
The [Properties] dialog box appears.

You can change the frame shape.

To change the frame width
Drag the [     ] marks on the screen to adjust the width of the frame.

To delete frame
You can delete frame.

To change the frame height
Input a value to specify the height of
the frame.

ROSE

To change the frame location
Move and rotate the frame by
dragging it up, down, or to the left or
right.
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2-3 Creating Processing Data

Specifying the Processing Conditions

Specify the processing conditions.

1 Click the [Cut Settings] button.
The [Cut Settings] dialog box appears.

2 Click [  ] and select the cut settings.

3 Click [  ] and select the cutter installing the
processing machine.

4 Set the rotation [50000] here.

When processing soft material, lowered rota-
tion.

5 Click [OK] to close the [Cut Settings] dialog box.
The edit screen appears.
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2-4 Saving Files

Saving the Edit Screen

Save the 3D image data.

1 Click the [Save As] button.
The [Save As] dialog box appears.

2 Specify a location to save the image file in and
type the file name.

3 Click [Save]
The 3D image data appears on the File management
screen.

Saving the File Management Screen

You can save 3D image data and image data on this screen.

1 From the [File] menu, click [Save As].
The [Save As File] dialog box appears.

2 Specify a location to save the list file in and
type the file name.

3 Click [Save].

File management screen
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2-5 Previewing a Processing Result

With Virtual MODELA, preview processing results before starting an actual processing operation.

1 Select the edited medal data, and double click.
The Edit screen appears.

2 Click the button.
Virtual MODELA starts up and the Simulation screen
appears.

3 The Virtual MODELA automatically simulates
the action of the cutter and displays the pro-
cessing result on the screen.

4 Click the button.
The [Cutting Data Information] dialog box appears.
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2-5 Previewing a Processing Result

5 Check the expected processing time, then click
[OK].

6 When save the simulation data, from the [File]
menu, select [Save Cutting Configuration].

7 Select the folder for saving the file, enter the
file name.

Click [Save].

8 Click , and close Virtual MODELA.
The Edit screen of Medal Editor appears.

6 minutes
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2-6 Processing

Starting Processing of a Material

1 Check that the material and cutter are properly
installed to the processing machine.

2 Click the [Cut Settings] button.
The [Cut Settings] dialog box appears.

3 Click [Output Device].
The [Print Setup] dialog box appears.

4 Check that the processing machine name you
want to use appears in the [Name] field.

5 Click [OK], and close the [Printer Settings] dia-
log box.
The [Cut Settings] dialog box appears.

6 Click [OK], and close the [Cut Settings] dialog
box.
The Edit screen appears.

7 Click the [Cut] button.
The confirmation screen appears.

8 Click [OK].
The processing machine is activated and starts to pro-
cess.
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2-6 Processing

Canceling the Processing Operation

1 Stop the processing operation temporarily.

2 Windows XP

Click [Start]-[Control Panel] and then click [Print-
ers and Other Hardwares]- [Printers and Faxes].

Windows 98/Me/2000

Click [Start].

Point to [Settings] and click [Printers].

3 Double-click the processing machine icon.

4 Windows XP/2000

From the [Printer] menu, click [Cancel All

Documents].

Windows 98/Me

From the [Printer] menu, click [Purge Print Jobs]
or [Purge Print Documents] to stop sending
data.

5 Delete the processing data from the process-
ing machine.
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MEMO
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MEMO
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Please read this agreement carefully before opening the sealed
 package or the sealed disk package

Opening the sealed package or sealed disk package implies your acceptance of the terms and conditions of this agreement.

Roland License Agreement

Roland DG Corporation ("Roland") grants you a non-assignable and non-exclusive right to use the COMPUTER
PROGRAMS in this package ("Software") under this agreement with the following terms and conditions.

1. Coming into Force This agreement comes into force when you purchase and open the sealed package
or sealed disk package.
The effective date of this agreement is the date when you open the sealed package
or sealed disk package.

2. Property Copyright and property of this Software, logo, name, manual and all literature for
this Software belong to Roland and its licenser.

The followings are prohibited :
(1) Unauthorized copying the Software or any of its support file, program module

or literature.
(2) Reverse engineering, disassembling, decompiling or any other attempt to

discover the source code of the Software.

3. Bounds of License Roland does not grant you to sub-license, rent, assign or transfer the right granted
under this agreement nor the Software itself (including the accompanying items)
to any third party.
You may not provide use of the Software through time-sharing service and/or
network system to any third party who is not individually licensed to use this
Software.

You may use the Software by one person with using a single computer in which
the Software is installed.

4. Reproduction You may make one copy of the Software only for back-up purpose. The property
of the copied Software belongs to Roland.
You may install the Software into the hard disk of a single computer.

5. Cancellation Roland retains the right to terminate this agreement without notice immediately
when any of followings occurs :
(1) When you violate any article of this agreement.
(2) When you make any serious breach of faith regarding this agreement.

6. Limitations on Liability Roland may change the specifications of this Software or its material without
notice.

Roland shall not be liable for any damage that may caused by the use of the
Software or by exercise of the right licensed by this agreement.

7. Governing Law This agreement is governed by the laws of Japan, and the parties shall submit to
the exclusive jurisdiction of the Japanese Court.


